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 Overview      
SpeakOut! is an application designed to help you write a letter to Congress.    All you have to 
do is enter the text of the letter and tell the system which members of Congress to direct it 
too, and SpeakOut! does the rest.    If you like you can also use some simple style and 
formatting features to give your letter the look that you desire.
Describing your target group to SpeakOut! is as easy as pointing and clicking.    A special 
Recipient Group Editor allows you to define certain criteria for member inclusion, such as 
what committees they are in, what state they are from, what party they are in, and so on.    
You can also select specific Congresspeople by name. 
Once you have set up your letter and defined your target group you can preview the letter 
(in a true WYSIWYG window) to make any final adjustments before printing.    SpeakOut! will 
also print mailing labels and return address labels for you when you are ready to send.
In designing the application our overriding goal was simplicity.    All of us have had the 
experience of trying to create a simple document with a word processor only to find that an 
elaborate set of    ‘powerful’ features is keeping us from doing what we want.    While 
SpeakOut! may not be appropriate for people who have very advanced letter writing needs, 
we feel that for the rest of us it will be an uncommonly easy tool to use.
 
 



 Getting Started      
This section will take you through the process of creating a simple mailing.    We assume that
you are comfortable using the basic Windows controls.    If you are not, you should consult 
your Windows documentation before continuing.

Step 1: Enter Your Return Address. 
Click the Add button in the Return Address section of the Main Screen.    SpeakOut! adds a 
new return address to the system and gives it the text: '<new return address>'.    Replace 
that text with the text of your return address, including your name.

Step 2: Select a Date Style
Click the drop down arrow on the Date Style combo box and select an option.    

Step 3: Modify the Date
If you do not want to use today's date select the Set Letter Date... menu item under the 
Preferences menu.    This brings up the Date Editor.    Enter the date that you prefer and click 
the OK button.

Step 4: Select a Greeting Style
Click the drop down arrow on the Greeting Style combo box and select an option.

Step 5. Enter Your Letter Body.
Click the Add button In the Letter Body section.    SpeakOut! adds a new letter body to the 
system and gives it the text: '<new letter body>'.    Replace that text with the text of your 
letter.

 To save time click this button for a sample letter body that you can copy 
and paste into the Letter Body edit box.    Once you have copied it into the clipboard select 
the current text of your new body and paste from the clipboard (Shift+Insert).    Now replace 
the '<your name>' part of the body with your name.

Step 6: Define Your Target Group
Click the Add button in the Recipient Group section.    This brings up the Recipient Group 
Editor so that you can select the criteria for your new group.    Based on the contents of the 
sample letter, let's assume that you want your mailing to go to all Democratic 
Representatives from Pennsylvania and Ohio who are in either the Environment and Public 
Works committee or the Transportation and Infrastructure committee.    First click on the 
Democratic check box in the Party section to turn it on.    Notice that the description at the 
bottom of the dialog box has changed from 'All Congresspeople' to 'Democratic 
Congresspeople' and the letter count (just above the description at the right) has changed 
from 540 to 257.    Continue to watch the description and letter count as you complete the 
following steps.    Click on the Representative check box in the Office section to turn it on.    
Scroll down in the Home State listbox to bring both Ohio and Pennsylvania into view.      Click 
on Ohio, then hold down the Ctrl key and click on Pennsylvania.    This will select both states. 
Click on the Committee tab at the top of the dialog box to bring the committee criteria page 



into view.    Scroll down to bring the Environment and Public Works committee into view and 
click on it.    Scroll down to the Transportation and Infrastructure committee and hold down 
the Ctrl key and click on it.    Now both committees are selected.    Enter the name 'OHIO 
RIVER HIGHWAY' in the Name edit box.    Click the OK button.

Step 7: Preview Your Letter to Determine Spacing Needs
Click the Preview button at the top of the Main Screen.    This brings up the Preview window 
with your letters loaded.    Click the Zoom button to get a full page view.    Since the body of 
your letter is fairly short you will want to increase the default spacing to get a better look.    
Click the Close button to put away the Preview window.    Click the Set Spacing... button in 
the Letter Body section.    This brings up the Spacing Editor so you can adjust the spacing.    
Set the spacing between the return address and date to 4, between the date and recipient 
address to 5, and between the recipient address and greeting to 3.    Click the OK button.    
You can keep previewing and adjusting the spacing in this manner until the letter has the 
look that you want.

Step 8: Print your Letters
Click the Print button at the top of the Main Screen and your letters will be printed.    If you 
do not want them to go to the Windows default printer select the Print Setup... menu item 
under the File menu.    This brings up Window's Print Setup dialog box so you can select a 
different printer.

Step 9: Print Mailing Labels
Select the appropriate Use Labels menu item under the Preferences menu.    Even if you are 
not using Avery labels, your labels will probably be compatible with one of the Avery options.
Put a label sheet in your printer and select the Print Mailing Labels menu item under the File 
menu.

Step 10: Print return Address Labels
Assuming you are using the same label type for return address labels, put a label sheet in 
your printer and select the Print Return Address Labels menu item under the File menu.

You're Done
Congratulations!    You have created a simple (and small) mailing complete with letters and 
labels.    Notice that as you create more mailings some of these steps will not be necessary.    
For example you may always use the same return address, date style, greeting style, etc.    
Or you may already have created a recipient group that you want to use again.    The rest of 
this help file describes the features you have just used as well as some others in more detail 
if you need more help.



 
As a Pennsylvania Democrat and resident of Pittsburgh I am deeply concerned about House 
bill 123.    As you know, if passed this bill would provide for the creation of a major highway 
to run the banks of the Ohio river from Pittsburgh to Cincinatti.    There is a great deal of 
wildlife that depends on the vegetation of the banks for survival.    Without that plant life the 
ecosystem along the river would be altered substantially.    I am not an ecologist so I cannot 
tell you exactly what impact might be expected, but I would like to make sure that you are 
informed as to the implications before you vote on 123.    Please send me whatever data you 
have regarding environmental impact.    If none is available I strongly encourage you to vote 
against the bill or to postpone the vote until members can receive an environmental impact 
analysis.    Thanks in advance for your cooperation.    I look forward to your response.

 

                                                                                                                                                        Sincerely,
 

                                                                                                                                                        <your name>



 The Main Screen      
The SpeakOut! main screen is the screen that comes up when you run the application.    
Most of the work that you need to do to set up and print a new mailing can be done from this
screen.    The screen is designed to mimic the layout of a letter.    
The main screen consists of five basic sections:    the Recipient Group section, the Return 
Address section, the Letter Body section, the Greeting Style combo box and the Date Style 
combo box.    It also contains the Preview and Print buttons, a Menu Bar and a Status Bar.
To create a mailing you just need to set the data in each of the five sections to reflect what 
you want in your mailing.    Then you can click on the Preview or Print buttons to see the 
results.    If you need to print mailing labels or return address labels you can use the 
previewing and printing options under the File menu.    Notice that when you are printing 
labels they will be designed to fit the Avery label type selected under the Preferences menu.

Context Sensitive Help
If you hit F1 at the main screen you will be presented with help information on the currently 
active control.    If you hit F1 with a menu item selected you will get help information for that 
menu item.

The Preview button
Clicking on the Preview button brings up the Preview window with the letters in the current 
mailing loaded.    The current mailing is defined by the settings in each of the five main 
sections.    The Preview window enables you to see what your letters will look like before 
actually printing them.    You can use the buttons on the Preview window to move through 
the various letters in your mailing and to zoom in and out on the images.    Clicking on the 
Preview button is identical to selecting the Preview Letters menu item under the File Menu.

The Print Button
Clicking on the Print button prints all of the letters in the current mailing.    The current 
mailing is defined by the settings in each of the five main sections.    Printing is directed to 
the printer selected using the Print Setup dialog box.    You can bring up the Print Setup 
dialog box by selecting the Print Setup... menu item under the File Menu.    If you do not 
select a printer SpeakOut! uses the Windows default printer.    Clicking on the Print button is 
identical to selecting the Print Letters menu item under the File menu.



 Return Address Section      
The Return Address section of the Main Screen allows you to maintain a list of return 
addresses.    The address that is displayed is the one that will be used when printing letters 
or return address labels.

To scroll down to help on a specific control click on it in the image below.

 
Once you have set up your list to contain all the return addresses that you want, all you 
have to do is select the appropriate one.    You may want to have one return address for 
yourself as a private citizen, one as a representative of your company or other organization, 
one for your spouse or child, etc.    Notice that the text at the upper right indicates how 
many addresses you have in your list and which one is currently displayed.
The information below describes how to add, delete and modify addresses to set up your list,
and how to move through the list to select the address that you want.

Address Edit Box
The address edit box is used to enter or modify the text of a return address.    Just as with 
any Windows edit box you can select text to delete or change and you can cut and paste to 
and from the clipboard.    For more information on using Windows edit boxes consult your 
Windows manuals.    The smaller scroll bar attached to the address edit box is used to see 
the rest of the address if it contains more than the four lines that are visible at a time.

Add Button
The Add button adds a new return address to the end of your list and moves to it.    When it 
is created the new address reads '<new return address>'.    You should replace this text with 
the text of your new address.

Delete Button
The Delete button removes the currently displayed address from your list.    You will be asked
to verify the deletion because it is permanent.    If there is only one address in your list you 
will not be permitted to delete it.    SpeakOut! requires that you have at least one address in 
your list at all times.

List Slide Bar
The list slide bar all the way at the right of the Return Address section is used to select a 
return address.        When it is all the way at the top the first address in the list is displayed.    
When it's all the way at the bottom the last is displayed.    You can drag the thumbnail to flip 
through the addresses in your list.



 Letter Body Section      
The Letter Body section of the Main Screen allows you to maintain a list of letter bodies.    
The body that is displayed is the one that will be used when printing letters. 

To scroll down to help on a specific control click on it in the image below.

 
Every time you create a new letter body it is added to your list.    If you want to use the same
body again for a different mailing all you have to do is find it in the list.    Notice that the text 
at the upper right indicates how many letter bodies you have and which one is currently 
displayed.
The information below describes how to add, delete and modify bodies to set up your list, 
and how to move through the list to select the body that you want.

Letter Body Edit Box
The letter body edit box is used to enter or modify the text of a letter body.    Just as with any
Windows edit box you can select text to delete or change and you can cut and paste from 
the clipboard.    For more information on using Windows edit boxes consult your Windows 
manuals.    The smaller scroll bar attached to the letter body edit box is used to see the rest 
of the body if it contains more lines than are visible.

Add Button
The Add button adds a new letter body to the end of your list and moves to it.    When it is 
created the new body reads '<new letter body>'.    You should replace this text with the text 
of your new body.

Delete Button
The Delete button removes the currently displayed letter body from your list.    You will be 
asked to verify the deletion because it is permanent.    If there is only one body in your list 
you will not be permitted to delete it.    SpeakOut! requires that you have at least one body 
in your list at all times.

List Slide Bar
The list slide bar all the way at the right of the Letter Body section is used to select a letter 
body.        When it is all the way at the top the first body in the list is displayed.    When it's all 



the way at the bottom the last is displayed.    You can drag the thumbnail to flip through the 
bodies in your list.

Set Spacing... Button
Every letter body contains spacing information that you control.    This tells SpeakOut! how 
to space the various elements of a letter (return address, date, greeting, etc.).    The Set 
Spacing... button bring up the Spacing Editor so that you can format the spacing to suit your 
taste.    You can preview the letter to see how the spacing you have selected will actually 
look when printed.



 Recipient Group Section      
The Recipient Group section of the Main Screen allows you to maintain a list of recipient 
groups.    A recipient group is a group of Congresspeople that you might wish to send a letter
to.    The group that is displayed is the one that will be used when printing letters or mailing 
labels.

To scroll down to help on a specific control click on it in the image below.

 
Every time you create a new recipient group it is added to your list.    If you want to use the 
same group again for a different mailing all you have to do is find it in the list.    Notice that 
the text at the upper right indicates how many groups you have and which one is displayed.
The information below describes how to add, delete and modify groups to set up your list, 
and how to move through the list to select the group that you want.

Recipient Group Edit Box
The recipient group edit box is used to view a description of the group.    You cannot edit this 
text directly.    If you want to change the criteria of the group you must click the Edit button.   
The smaller scroll bar attached to the recipient group edit box is used to see the rest of the 
description if it contains more lines than are visible.

Add Button
The Add button adds a new recipient group to the end of your list and moves to it.    First the 
Recipient Group Editor dialog box is presented so that you can set the criteria for your new 
group.    If you click the Cancel button on the Recipient Group Editor a new group is not 
created.

Delete Button
The Delete button removes the currently displayed recipient group from your list.    You will 
be asked to verify the deletion because it is permanent.    If there is only one group in your 
list you will not be permitted to delete it.    SpeakOut! requires that you have at least one 
group in your list at all times.

Edit Button
The Edit button brings up the Recipient Group Editor dialog box so you can modify the 
criteria of the current group.    When you have completed your changes the description in the
recipient group edit box will change to reflect them.

List Slide Bar



The list slide bar all the way at the right of the Recipient Group section is used to select a 
recipient group.    When it is all the way at the top the first group in the list is displayed.    
When it's all the way at the bottom the last is displayed.    You can drag the thumbnail to flip 
through the groups in your list.



 Date Style Combo Box    
The Date Style combo box on the Main Screen allows you to select a style for your letter's 
date.    The image below illustrates some of the styles that are available.

 
If you want to change the actual date (SpeakOut! uses the current date by default) you must
select the Set Letter Date... menu item from the Preferences menu.    This brings up the Date
Editor dialog box so you can enter a new date.



 Greeting Style Combo Box    
The Greeting Style combo box on the Main Screen allows you to select a style for your 
letter's greeting.    The image below illustrates the styles that are available.

 
The names in the combo box are just used to illustrate the style.    When your letters are 
printed the appropriate names will be inserted for each letter.
 



 Menu Items      
The SpeakOut! menu bar has three menus.    Select the menu that you would like to see 
information on.

    File Menu 
    Edit Menu
    Preferences Menu
    Help Menu

 



 File Menu      
The File menu contains the menu items used for preview and printing letters, mailing labels 
and return address labels.    It also provides access to Congresspeoples' phone numbers.

To scroll down to help on a specific menu item click on it in the image below.

 

Preview Letters (hot key: Ctrl+L)
The Preview Letters menu item brings up the Preview window with the all the letters for the 
current mailing loaded.    You can use the Preview window to flip through all of the letters in 
the mailing.    If your letters look OK for printing there is a Print button available at the 
bottom of the window.

Preview Mailing Labels (hot key: Ctrl+M)
The Preview Mailing Labels menu item brings up the Preview window with the all the mailing 
labels for the current mailing loaded.    You can use the Preview window to flip through the 
label sheets if more than one is required.    If your labels look OK for printing there is a Print 
button available at the bottom of the window.    The labels will be set up to fit on the label 
type that you have selected under the Preferences menu.

Preview Return Address Labels (hot key: Ctrl+R)
The Preview Return Address Labels menu item brings up the Preview window with the all the 
return address labels for the current mailing loaded.    You can use the Preview window to flip
through the label sheets if more than one is required.    If your labels look OK for printing 
there is a Print button available at the bottom of the window. The labels will be set up to fit 
on the label type that you have selected under the Preferences menu.

Print Letters (hot key: Ctrl+T)
The Print Letters menu item prints all the letters for the current mailing.    One copy of each 
letter will be printed.    If you wish to print more than one copy or if you wish to print only 
certain letters, use the Preview Letters menu item to bring up the Preview window and then 
click on its Print button.    This will give you the opportunity to specify what you want printed.

Print Mailing Labels (hot key: Ctrl+G)



The Print Mailing Labels menu item prints all the mailing labels for the current mailing.    One 
copy of each label will be printed.    If you wish to print more than one copy or if you wish to 
print only certain label sheets, use the Preview Mailing Labels menu item to bring up the 
Preview window and then click on its Print button.    This will give you the opportunity to 
specify what you want printed.    The labels will be set up to fit on the label type that you 
have selected under the Preferences menu.

Print Return Address Labels (hot key: Ctrl+N)
The Print Return Address Labels menu item prints all the return address labels for the current
mailing.    One copy of each label will be printed.    If you wish to print more than one copy or 
if you wish to print only certain label sheets, use the Preview Return Address Labels menu 
item to bring up the Preview window and then click on its Print button.    This will give you 
the opportunity to specify what you want printed.    The labels will be set up to fit on the 
label type that you have selected under the Preferences menu.

Print Setup...
The Print Setup... menu item brings up Windows' Print Setup dialog box.    This allows you to 
select which printer you want to use.    If you do not select a printer SpeakOut! uses the 
Windows default printer.

Phone Numbers...
The Phone Numbers... menu item brings up the Phone Number Display.    This dialog box 
shows you the phone numbers of the Congresspeople in the current mailing.    The dialog box
has a Print button if you want to print the numbers out.

Exit
The Exit menu item shuts down SpeakOut!    As with all Windows applications this can also 
be done by double-clicking on the control box in the upper left corner of the window or by 
hitting Alt+F4.



 Edit Menu      
The Edit menu allows you to Cut, Copy and Past text between SpeakOut! and other Windows
applications.

To scroll down to help on a specific menu item click on it in the image below.

 

Cut (hot key: Ctrl+X)
The Cut menu item deletes any text that is selected in the letter body or return address 
sections, and copies it into the Windows clipboard for pasting into other applications.
Copy (hot key: Ctrl+C)
The Copy menu item copies any text that is selected in the letter body or return address 
sections into the Windows clipboard for pasting into other applications.

Paste (hot key: Ctrl+V)
The Paste menu item inserts any text that is in the Windows clipboard into the letter body or
return address section.    The section that contains the cursor will receive the text.

Delete (hot key: Del)
The Delete menu item removes any text that is selected in the letter body or return address 
sections.    The text is not copied into the Windows clipboard.
Select All
The Select All menu item selects all the text in the letter body or return address section.    
The section that contains the cursor will have its text selected.



 Preferences Menu      
The Preferences menu contains the menu items used to configure SpeakOut! to suit your 
needs.

To scroll down to help on a specific menu item click on it in the image below.

  

Show Hints (hot key: Ctrl+H)
The Show Hints menu item toggles whether or not the system's hint window is used.    The 
hint window is a small popup window that appears next to the control the mouse over.    It 
contains a very brief explanation of what the control does.    When this menu item is checked
the hint window will be shown, when it is not checked it will not be shown.

Show Status Bar Messages (hot key: Ctrl+S)
The Show Status Bar Messages menu item toggles whether or not help messages are shown 
in the status bar at the bottom of the Main Screen.    If messages are shown they apply to the
control the mouse is over.    Status bar messages are slightly longer than hint window 
messages.    When this menu item is checked status bar messages will be shown, when it is 
not checked they will not be shown.

Use Labels Items
The Use Labels menu items are used to indicate which type of label sheet you want your 
mailing labels and return address labels formatted for.    The menu item that is checked is 
the one that will be used when printing labels.    Each of the choices indicate which Avery 
label types match, as well as the number of rows and columns that the label sheets have.    
To preview or print labels use the previewing and printing options under the File menu.

Set Letter Date... (hot key: Ctrl+D)
The Set Letter Date... menu item brings up the Date Editor dialog box.    This dialog box 
allows you to indicate the date that you want to appear on your letter.    SpeakOut! uses the 
current date by default.



 Help Menu      
The Help menu provides access to the SpeakOut! help system.

To scroll down to help on a specific menu item click on it in the image below.

 

Table of Contents
The Table of Contents menu item brings up the help system open to the Table of Contents 
page.

Step By Step Tutorial
The Step By Step Tutorial menu item brings up the help system open to the Getting Started 
page.

Help on Help
The Help on Help menu item brings up the help system with information on how to use the 
help system itself.

About...
The About... menu item brings up the SpeakOut! about box.    The about box presents 
version and copyright information.



 Dialog Boxes      
Although much of the work you will do with SpeakOut! will be done on the Main Screen, 
there are also some dialog boxes that the system uses to gather and display additional 
information.    Select the dialog box that you would like to see information on.

    Recipient Group Editor
    Spacing Editor
    Date Editor
    Phone Number Display



 Recipient Group Editor      
The Recipient Group Editor allows you to set the criteria for a recipient group.    The editor is 
presented if you edit an existing recipient group or if you add a new one.

To scroll down to help on a specific control click on it in the image below.

    
There are five criteria categories: Party, Office, Home State, Committee and Individual.    A 
Congressperson must match the settings in all of these sections to be included in the group. 
For example if Party is set to Democratic, and Office is set to Senator then a Congressperson
will be included only if they are a Democrat and a Senator.    If a section is not relevant to the
group you are trying to define then you should set its Active switch to Off (the Active switch 
is in the upper right hand corner of each section).    
Generally you will use either a combination of the first four categories to set up the criteria 
for a group, or you will use only the Individual section to indicate a list of specific 
Congresspeople.    You can combine all of the sections if you wish however.    For example, 
imagine you have a list of twenty Congresspeople you wish to contact but you want to send 
a slightly different letter to the Senators in the group.    You should select each of members in
the Individual section and then check the Senator check box in the Office section.    This will 
generate a group representing the Senators in your list.    You can generate a group 
representing the Representatives in your list similarly.
The description of the group at the bottom of the dialog box should make clear the meaning 
of the criteria you have selected.

Party



Use the Party section to indicate which party or parties to include in your group.    Check the 
ones that should be included.

Active Switch
The Active switch indicates whether or not party membership is relevant to the group.    
If it is not, set the switch Off and members will be included regardless of their party.    
The switch is turned on automatically as soon as you select a subset of the parties for 
inclusion.

Office
Use the Office section to indicate which branch(es) of Congress to include in your group.    
Check the branch(es) that should be included.

Active Switch
The Active switch indicates whether or not office is relevant to the group.    If it is not, set
the switch Off and members will be included regardless of their office.    The switch is 
turned on automatically as soon as you select a subset of the branches for inclusion.

Home State
Use the Home State section to indicate which home state(s) to include in your group.    
Highlight the states that should be included.

Active Switch
The Active switch indicates whether or not home state is relevant to the group.    If it is 
not, set the switch Off and members will be included regardless of their home state.    
The switch is turned on automatically as soon as you select a subset of the states for 
inclusion.

Committee
Use the Committee section to indicate which committee(s) to include in your group.    
Highlight the committees that should be included.

Active Switch
The Active switch indicates whether or not committee membership is relevant to the 
group.    If it is not, set the switch Off and members will be included regardless of what 
committees they are in.    The switch is turned on automatically as soon as you select a 
subset of the committees for inclusion.

Individual
Use the Individual section to indicate which individual Congresspeople to include in your 
group.    Highlight the Congresspeople who should be included.

Active Switch
The Active switch indicates whether or not Congresspeople should be individually 
selected for the group.    If not, set the switch Off and members will be included based 
only on the other criteria.    The switch is turned on automatically as soon as you select a
subset of the Congresspeople for inclusion.

Name
Use the Name edit box to enter a name for your group.    Names are added as the first line of
the group's description.    You do not have to enter a name if the description is adequate 
without it.

Description



The Description edit box gives you an written description of the group you have defined.    If 
you have entered a name for the group it will appear as the first line of the description.    
Notice that the text at the upper right indicates how many letters the group will generate.    
The scroll bar attached to the Description edit box is used to see the rest of the description if
it contains more lines than are visible.

OK Button
The OK button accepts the changes you have made to a group's criteria.    If you are adding 
a recipient group the OK button creates a new group based on the criteria.

Cancel Button
The Cancel button aborts any changes you have made to a group's criteria.    If you are 
adding a recipient group the Cancel button aborts creation of the new group.

Help Button
The Help button brings up this help page (scrolled to the top) to give you information on the 
Recipient Group Editor dialog box.    If you hit F1 while the Recipient Group Editor is up you 
will be presented with this help page scrolled to the section describing the control that is 
active.



 Spacing Editor      
The Spacing Editor allows you to set the spacing of the various elements of a letter (return 
address, date, greeting, etc.).    The editor is presented if you click the Set Spacing... button 
in the Letter Body section of the Main Screen.    Every letter body contains its own spacing 
information.    You can preview the letter to see how the spacing you have selected will 
actually look when printed.

To scroll down to help on a specific control click on it in the image below.

 

Spacing Between Return Address and Date
Sets the number of blank lines between the return address and the date.    You can type a 
new number or use the arrow buttons to increase or decrease the number to the desired 
value.

Spacing Between Date and Recipient Address
Sets the number of blank lines between the date and the recipient address.    You can type a 
new number or use the arrow buttons to increase or decrease the number to the desired 
value.

Spacing Between Recipient Address and Greeting
Sets the number of blank lines between the recipient address and the greeting.    You can 
type a new number or use the arrow buttons to increase or decrease the number to the 
desired value.

OK Button
The OK button accepts the changes you have made to a letter's spacing.



Cancel Button
The Cancel button aborts any changes you have made to a letter's spacing.

Help Button
The Help button brings up this help page (scrolled to the top) to give you information on the 
Spacing Editor dialog box.    If you hit F1 while the Spacing Editor is up you will be presented 
with this help page scrolled to the section describing the control that is active.



 Date Editor      
The Date Editor allows you to set a date for your letter.    The editor is presented if you select
the Set Letter Date... menu item from the Preferences menu.    By default SpeakOut! uses 
the current date.    To change the style of the date use the Date Style combo box on the Main
Screen.

To scroll down to help on a specific control click on it in the image below.

 

Month
Sets the month.    You can type a new number or use the arrow buttons to increase or 
decrease the number to the desired value.

Day
Sets the day.    You can type a new number or use the arrow buttons to increase or decrease 
the number to the desired value.

Year
Sets the year.    You can type a new number or use the arrow buttons to increase or decrease
the number to the desired value.

OK Button
The OK button accepts the changes you have made to the date.

Cancel Button
The Cancel button aborts any changes you have made to the date.

Help Button
The Help button brings up this help page (scrolled to the top) to give you information on the 
Date Editor dialog box.    If you hit F1 while the Date Editor is up you will be presented with 
this help page scrolled to the section describing the control that is active.

 



 Phone Number Display
The Phone Number Display allows you to view the phone numbers of the Congresspeople in 
the current recipient group.    The dialog box is presented if you select the Phone Numbers... 
menu item from the File menu.

To scroll down to help on a specific control click on it in the image below.

 

Phone Number List
Shows the names and phone numbers of the Congresspeople in the current recipient group.  
Use the scroll bar to view entries that do not fit in the display.

Print Button
The Print button prints out the numbers in the display.

Close Button
The Close button puts away the Phone Number Display dialog box.

Help Button
The Help button brings up this help page (scrolled to the top) to give you information on the 
Phone Number Display dialog box.    If you hit F1 while the Phone Number Display is up you 
will be presented with this help page scrolled to the section describing the control that is 
active.



 The Preview Window      
The Preview window allows you to look at your letters, mailing labels and return address 
labels on screen before printing them.    The images are shown as they will appear when 
printed.    This way you can use the Preview window to make formatting adjustments rather 
than printing.    This saves both time and paper.

To scroll down to help on a specific control click on it in the image below.

 

First Button
The First button flips to the first letter or label sheet (see Location Indicator).

Previous Button
The Previous button flips to the previous letter or label sheet (see Location Indicator).

Location Indicator
The location indicator shows which letter or label sheet is currently displayed and how many 
have been loaded for previewing.

Next Button
The Next button flips to the next letter or label sheet (see Location Indicator).



Last Button 
The Last button flips to the last letter or label sheet (see Location Indicator).

Zoom Button
The Zoom button cycles through three different zoom levels.    You can zoom all the way out 
to get a view of the overall layout of the page (as in the above image), or zoom in to see 
more detail.

Print... Button 
The Print... button will print the material that you are previewing.    First you will be 
presented with the Windows Print dialog box.    This dialog box allows you to indicate which 
pages to print and how many copies to print.
Close Button
The Close button closes down the Preview window.

Help Button
The Help button brings up this help page (scrolled to the top) to give you information on the 
Preview window.    If you hit F1 while the Preview window is up you will be presented with this
help page scrolled to the section describing the control that is active.

Stop Loading Button
The Stop Loading button will abort the process of loading letters or label sheets into the 
Preview window.    If you are previewing the letters for a large mailing it will take a few 
second to load all of the letters.    If you do not want to wait for them all to load you can click 
the Stop Loading button and begin using the Preview window with just the letters that have 
been loaded so far.



 Messages      
The following list contains all of the messages that SpeakOut! might present to you during 
ordinary usage.

'Deleting this <return address/letter/recipient group> will permanently remove it 
from the system.    Delete anyway?'
This message is shown to make sure that you really want to delete the item.    Once you 
delete it you will not be able to get it back.    This is a precaution in case you clicked the 
Delete button by accident.
Yes button: item is deleted.
No button: nothing is done.
Help button: this help message is shown.

'This <return address/letter/recipient group> cannot be deleted.    You must 
maintain at least one <return address/letter/recipient group> in the system at
all times.'
This message is shown to let you know that the item will not be deleted, despite your 
request.    If your return address list, letter list or recipient group list contains only one 
item it cannot be deleted.
OK button: nothing is done.
Help button: this help message is shown.

'The current recipient group does not contain any Congresspeople.    There is 
nothing to <preview/print/show>.'
This message is shown to let you know that nothing will be previewed or printed, despite
your request.    If the recipient group you have chosen contains no Congresspeople then 
there is nothing to preview or print.
OK button: nothing is done.
Help button: this help message is shown.



 Errors
When SpeakOut! encounters an unexpected error it is first reported to the user and then 
SpeakOut! is terminated.    Regardless of the error, the message dialog box will have the 
following two buttons.

OK button: SpeakOut! is terminated.
Help button: this help page is shown scrolled down to the explanation of the error.

When an error occurs you should do the following:
1) write down the error code and error message,
2) click the OK button on the message dialog box to allow SpeakOut! to terminate.
3) close down all other applications and exit Windows.
4) at the DOS prompt, turn your computer off and then on again, run Windows again if it 
doesn't run automatically, and try running SpeakOut! again.

If the error occurred due to another application SpeakOut! should run correctly.    If it doesn't,
find the error below to check for a tip, or contact Publishing Technologies for assistance.
Note: Certain low level system errors will not display an error code and do not have an 
explanation below.    You should still follow the instructions above.

Error Codes and Messages

CB001: 'Field <field name> not found in database file <file name>'
There is an internal error in the database file 'file name'.    Replacing from a backup 
should solve the problem.    Follow the instructions at the top of this help page before 
proceeding. 

CB002, CB003, CB004: 'Unable to get value for field <field name> in database file 
<file name>'
There is an internal error in the database file 'file name'.    Replacing from a backup 
should solve the problem.    Follow the instructions at the top of this help page before 
proceeding.

CB005: 'Unable to set value for field <field name> in database file <file name>'
There is an internal error in the database file 'file name'.    Replacing from a backup 
should solve the problem.    Follow the instructions at the top of this help page before 
proceeding.

CB006: 'Unable to open database file <file name>'
The database file 'file name' is missing or corrupted.    Replacing from a backup should 
solve the problem.    Follow the instructions at the top of this help page before 
proceeding.

CB007: 'Unable to close database file <file name>'
Access to database 'file name' was lost during execution.    Database may be corrupted 
after termination.    Follow the instructions at the top of this help page before 



proceeding.

CB008: 'Unable to go to top of database file <file name>'
Access to database 'file name' was lost during execution.    Database may be corrupted 
after termination.    Follow the instructions at the top of this help page before 
proceeding.

CB009: 'Unable to go to bottom of database file <file name>'
Access to database 'file name' was lost during execution.    Database may be corrupted 
after termination.    Follow the instructions at the top of this help page before 
proceeding.

CB010: 'Unable to skip <n> record(s) in database file <file name>'
Access to database 'file name' was lost during execution.    Database may be corrupted 
after termination.    Follow the instructions at the top of this help page before 
proceeding.

CB011: 'Unable to get record count for database file <file name>'
Access to database 'file name' was lost during execution.    Database may be corrupted 
after termination.    Follow the instructions at the top of this help page before 
proceeding.

CB012: 'Unable to find index <index name> for database file <file name>'
The database index 'index name' is missing or corrupted.    Replacing the database file 
'file name' and associated files (.cdx and .fpt) from a backup should solve the problem.    
Follow the instructions at the top of this help page before proceeding.

CB013: 'Unable to skip while counting records in database file <file name>'
Access to database 'file name' was lost during execution.    Database may be corrupted 
after termination.    Follow the instructions at the top of this help page before 
proceeding.

CB014: 'Unable to start append for database file <file name> (error code <n>)'
Access to database 'file name' was lost during execution.    Database may be corrupted 
after termination.    Follow the instructions at the top of this help page before 
proceeding.

CB015: 'Unable to end append for database file <file name> (error code <n>)'
Access to database 'file name' was lost during execution.    Database may be corrupted 
after termination.    Follow the instructions at the top of this help page before 
proceeding.

CB016: 'Unable to go to bottom of database file <file name>'
Access to database 'file name' was lost during execution.    Database may be corrupted 
after termination.    Follow the instructions at the top of this help page before 
proceeding.

CB017: 'Unable to skip 1 record in database file <file name>'
Access to database 'file name' was lost during execution.    Database may be corrupted 
after termination.    Follow the instructions at the top of this help page before 



proceeding.

CB018: 'Unable to close databases'
Access to databases was lost during execution.    Databases may be corrupted after 
termination.    Follow the instructions at the top of this help page before proceeding.

CR001: 'Unable to open preview job <report name>'
The report file 'report name' is missing or corrupted.    Replacing from a backup should 
solve the problem.    Follow the instructions at the top of this help page before 
proceeding.

CR002: 'Unable to turn off the preview window controls'
An internal error in the report engine has occurred.    Follow the instructions at the top of 
this help page before proceeding.

CR003: 'Unable to output to the preview window'
An internal error in the report engine has occurred.    Follow the instructions at the top of 
this help page before proceeding.

CR004: 'Unable to get preview job status'
An internal error in the report engine has occurred.    Follow the instructions at the top of 
this help page before proceeding.

CR005: 'Unable to get preview window handle'
An internal error in the report engine has occurred.    Follow the instructions at the top of 
this help page before proceeding.

CR006: 'Unable to close preview job <report name>'
An internal error in the report engine has occurred while processing the report file 
'report name'.    Report file may be corrupted after termination.    Follow the instructions 
at the top of this help page before proceeding.

CR007: 'Unable to show first page'                                  
An internal error in the report engine has occurred.    Follow the instructions at the top of 
this help page before proceeding.

CR008: 'Unable to show previous page'
An internal error in the report engine has occurred.    Follow the instructions at the top of 
this help page before proceeding.

CR009: 'Unable to show next page'
An internal error in the report engine has occurred.    Follow the instructions at the top of 
this help page before proceeding.

CR010: 'Unable to show last page'
An internal error in the report engine has occurred.    Follow the instructions at the top of 
this help page before proceeding.

CR011: 'Unable to change preview zoom level'



An internal error in the report engine has occurred.    Follow the instructions at the top of 
this help page before proceeding.

CR012: 'Unable to turn on Evaluation Version banner'
An internal error in the report engine has occurred.    Follow the instructions at the top of 
this help page before proceeding.

CR013: 'Unable to open report engine'
An internal error in the report engine has occurred.    Follow the instructions at the top of 
this help page before proceeding.

CR014: 'Unable to open print job <report name>'
The report file 'report name' is missing or corrupted.    Replacing from a backup should 
solve the problem.    Follow the instructions at the top of this help page before 
proceeding.

CR015: 'Unable to send print job <report name> to printer'
An internal error in the report engine has occurred while processing the report file 
'report name'.    Report file may be corrupted after termination.    Follow the instructions 
at the top of this help page before proceeding.

CR016: 'Unable to close print job <report name>'
An internal error in the report engine has occurred while processing the report file 
'report name'.    Report file may be corrupted after termination.    Follow the instructions 
at the top of this help page before proceeding.

CR017: 'Unable to select printer <printer name>'
An internal error in the report engine has occurred.    Follow the instructions at the top of 
this help page before proceeding.



 Contacting Publishing
Technologies      

If you are having difficulty using SpeakOut! please contact us so that we may correct the 
problem.
If you have suggestions as to how we can improve our software we would greatly appreciate 
your input.
You may contact us in any of the following ways.    We thank you for your input.

Telephone: (212) 406-4955

Fax: (212) 587-1314

E-Mail: comments@pubtech.com

World Wide Web: www.pubtech.com

U.S. Mail: 
Publishing Technologies, Inc.
Attn: Customer Service
139 Fulton St., Suite 513
New York, NY 10038

 



 Style and Formatting Features      
SpeakOut! has a few basic features that allow you to adjust the style and formatting of your 
letters.    You can pick any one of several date styles and greeting styles.    You can set the 
spacing of the various elements of a letter (return address, date, greeting, etc.). And you can
set the date that you want to use for your letter.    Additionally, when printing mailing labels 
and return address labels you can select any one of several standard Avery label types to 
use.
 




